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Old spectral domain grid filters (OldGridFFT) (T38)
Note: We have created a new spectral domain grid filters tool, GridFFT.  See Spectral 
Domain Grid Filters (GridFFT) for details. This chapter refers to the old version of 
the tool.  Only use this chapter if you particularly want to refer to this older version.

You can use the INTREPID Spectral Domain Grid Filters to enhance a grid dataset 
by
• enhancing features so that you can analyse them to better effect,
• correcting the measured position of features,
• removing irrelevant features, patterns or 'noise' in the grid.
INTREPID Spectral Domain Grid Filters can 
• Prepare and transform your grid dataset from the spatial domain to the spectral 

domain, 
• Apply a range of geophysical, directional, noise removal and wavenumber 

dependent filters.  It can apply filters singly or combine as many as you wish.  
• Transform your grid dataset back to the spatial domain.

INTREPID spectral domain operations (OldGridFFT)
For full details of spectral domain operations and the spectral domain filters provided 
with INTREPID, see INTREPID spectral domain operations reference (R14)

Using the Spectral Domain Grid Filters tool (OldGridFFT)

>> To use Spectral Domain Grid Filters with the INTREPID graphic user 
interface
1 Choose FFT_Filter from the Filter menu of the Project Manager or use the 

command gfilter.exe.  INTREPID displays the Spectral Domain Grid Filters 
Main window.

2 If you have previously prepared file specifications and parameter settings for 
Spectral Domain Grid Filters, load the corresponding task specification file using 
Load Options from the File menu. (See Specifying Input and Output (Filtered) 
Datasets (OldGridFFT) below for detailed instructions.)  If all of the specifications 
are correct in this file, go to step 9.  If you wish to modify any settings, carry out 
the following steps as required.

3 Specify the grid dataset to be processed.  Use Open Input from the File menu.  
(See Specifying Input and Output (Filtered) Datasets (OldGridFFT) below for 
detailed instructions.)

4 If the input data is in the spatial domain, INTREPID displays the Pre-Filter 
Transformation dialog box.  Specify the pre-filter transformation and options as 
required, then choose OK.  (See Pre-Filter Transformation (OldGridFFT) below 
for detailed instructions.)

5 Specify the output grid dataset.  Use Specify Output from the File menu.  (See 
Specifying Input and Output (Filtered) Datasets (OldGridFFT) below for detailed 
instructions.)  INTREPID displays the Post-Filter Transformation dialog box. 

6 Specify the post-filter transformation and associated options as required, then 
choose OK.  (See Post-Filter Transformation (OldGridFFT) below for detailed 
instructions.)  
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7 If you wish to examine the colour display of the input dataset (after pre-filter 
transformation) in the Input Spectrum Display area and/or the Power Spectrum 
graph before applying any filters, choose Clear Filter, then choose Apply.  
INTREPID will carry out the transformation and display the input dataset.  You 
can examine the power spectrum graph of the dataset as described below.  See 
Previewing the transformed input dataset (OldGridFFT) below.

8 Use the filter menus and associated dialog boxes to select the filter options that 
you wish to use and specify their required parameters.  As you specify the filters, 
INTREPID displays a colour representation of the effects of the filter combination 
in the Filter Response area of the Spectral Domain Grid Filters Main window.  
(See INTREPID spectral domain operations reference (R14) and the sections 
following for detailed instructions.)  

9 Choose Apply.  INTREPID will perform the filter process and display the results 
of the filter in the Filtered Spectrum area of the of the Spectral Domain Grid 
Filters Main window.

10 INTREPID will perform the post-filter transformation as specified and save the 
dataset.  If you specified that INTREPID will regenerate the data gaps existing 
before the pre-filter transformation, specify the original spatial domain input 
dataset when prompted by INTREPID.  (See Post-Filter Transformation 
(OldGridFFT) below for information).  

11 If you wish to record the specifications for this process in a .job file in order to 
repeat a similar task later or for some other reason, use Save Options from the 
File menu. (See Specifying Input and Output (Filtered) Datasets (OldGridFFT) 
below for detailed instructions.)

12 If you wish to repeat the process, repeat steps 2–11, varying the parameters and/
or data files as required.

13 To exit from Spectral Domain Grid Filters, choose Quit from the File menu.
___

After a Spectral Domain Grid Filters process is complete you can 
• View a radially averaged power spectrum graph of the input and output datasets 

and 
• Display slope, y intercept and Spector Grant depth estimate for any straight line 

segment in the power spectrum graph.  
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To view these displays choose Radial Power Spectrum from the Window menu.  See 
The radially averaged power spectrum graph (OldGridFFT) below.

After using Spectral Domain Grid Filters you can carry out a more detailed inspection 
of the filtered grid using an INTREPID visualisation tool (See Visualisation (T26)).

You can choose options from the Help menu (See Help (OldGridFFT) below).

You can execute Spectral Domain Grid Filters as a batch task using a task 
specification (.job) file that you have previously prepared.  See Using task 
specification files (OldGridFFT) below for details.

Spectral Domain Grid Filters display (OldGridFFT)
The Spectral Domain Grid Filters Main window has three spectrum display boxes.  
Each box shows a spectrum for all directions.  
• The Input Spectrum box shows the spectrum of the input dataset in with energy 

shown using pseudocolour.
• The input spectrum display box is a graph of frequency versus energy in 

Fourier space. 
• The colours represent the energy, or amplitude of each frequency, where red is 

high, blue is low and black is zero energy. 
• The origin (zero frequency) occurs half way up the left side of the display, and 

is typically coloured red or yellow. The plot is symmetrical about this vertical 
edge, which has the spatial orientation of North–South. 

• The maximum frequency in the display is the Nyquist frequency for the data.  
• The frequency range (zero to Nyquist) is normalised to fit the input spectrum 

display box.
• Since the graph is radial, strictly speaking, you should view it as a semi-circle 

rather than as a rectangle. 
• The Filter Spectrum box represents the weights of the current filter specification 

using pseudocolour.
• After you apply a filter the Filtered Spectrum box shows the spectrum of the filter 

results with energy shown using pseudocolour.
The Spectral Domain Grid Filters Power Spectrum window contains a power 
spectrum graph for the most recently applied filter.  See The radially averaged power 
spectrum graph (OldGridFFT) below and "Power spectrum graphs" in INTREPID 
spectral domain operations reference (R14) for information about this.
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Specifying Input and Output (Filtered) Datasets (OldGridFFT)
Before using any grid filters, you must specify input and output datasets.

Choose the options as required from the File menu.  

In each case INTREPID displays an Open or Save As dialog box.  Use the directory 
and file selector to locate the file you require.  (See "Specifying input and output files" 
in Introduction to INTREPID (R02) for information about specifying files).  

If you wish to apply Spectral Domain Grid Filters to a dataset on a number of 
occasions you can save a copy of the transformed version (i.e., the spectral domain 
version).  You can specify this copy of the dataset as input in future sessions, and 
avoid unnecessary processing.  See Storing the transformed input dataset for later 
use (OldGridFFT) below for more information. 
Open Input Dataset Use this option to specify the grid dataset to be filtered.  

INTREPID will open the dataset file.  If the data is in the spatial domain 
INTREPID displays the Pre-Filter Transformation dialog box.  See Pre-Filter 
Transformation (OldGridFFT) below for further instructions.

Specify Output Dataset Use this option to specify the name for the grid dataset you 
are creating with this process.  INTREPID displays the Post-Filter 
Transformation dialog box.  After you complete this dialog box INTREPID may 
require you to specify the original spatial dataset (or other mask file as required).  
See Post-Filter Transformation (OldGridFFT) below for further instructions.

Load Options If you wish to use an existing task specification file to specify the 
Spectral Domain Grid Filters process, use this option to specify the task 
specification file required.  INTREPID will load the file and use its contents to set 
all of the parameters.  (See Displaying options and using task specification files 
(OldGridFFT) below for more information).

Save Options If you wish to save the current Spectral Domain Grid Filters file 
specifications and parameter settings as an task specification file, use this menu 
option to specify the filename and save the file.  (See Displaying options and using 
task specification files (OldGridFFT) below for more information).
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Pre-Filter Transformation (OldGridFFT)
After you specify an input dataset, if the data is in the spatial domain, INTREPID 
displays the Pre-Filter Transformation dialog box.

>> To specify the pre-filter transformation for a normal spatial domain 
dataset:
1 Turn on Detrend dataset and change the Degree of Detrend parameter if required.  

See "Detrending data values" in INTREPID spectral domain operations reference 
(R14) for an explanation of this process.

2 Select the Interpolate Gaps or Apply Maximum Entropy option.  See "Expanding 
the data area" in INTREPID spectral domain operations reference (R14) for 
information about the Interpolate Gaps and Apply Maximum Entropy options.

3 Turn on any edge region spatial filters that you require (Cosine Bell, Hanning, 
Hamming, Blackman, Triangular).  See "Damping of dataset edges before spectral 
transform" in INTREPID spectral domain operations reference (R14) for an 
explanation of these options.

4 Turn on Save FFT for repeated processing if 
• You will be performing another filter process in a subsequent Spectral Domain 

Grid Filters session or 
• You wish to save the spectral domain version of the dataset for some other reason.

See Storing the transformed input dataset for later use (OldGridFFT) below for 
details.

5 Choose OK.
You can use the pre-filter transformation for general processing of datasets.  See 
Other uses of the pre-filter and post-filter transformations (OldGridFFT) below for 
details.
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Storing the transformed input dataset for later use (OldGridFFT)
After INTREPID completes the pre-filter transformation it can retain the 
transformed input dataset for repeated grid filter processes.  

If you wish to retain the transformed dataset for filtering on another occasion turn on 
the Save FFT For Repeated Processing check box.  

INTREPID stores the results of the pre-filter transformation process as a grid 
dataset.  The name of the dataset is the name of the input dataset with FFT appended 
to it.  

These spectral domain grids have the same number of rows and columns as the 
expanded spatial domain grids before the transformation (See "Expanding the data 
area" in INTREPID spectral domain operations reference (R14)).  INTREPID exploits 
the symmetry in the spectral domain transformed data to achieve this. 

You can examine the spectral domain grids using visualisation tools in the same way 
as you would a spatial domain grid.

INTREPID stores the transformation parameters in a text file with the same name as 
the input dataset and the extension .fft.  It stores these files in the same directory 
as the input dataset.   See Fourier transform grid header files (OldGridFFT) below for 
details.

Fourier transform grid header files (OldGridFFT)
When you transform a grid to the spectral domain, INTREPID records information 
about the transformation in the Fourier transform grid header file.  This is an 
INTREPID auxiliary file with the extension .fft.  It contains an fftdata Begin – 
fftdata End block with a coefficient list and parameter values describing the 
transformed grid.  The file contains information that INTREPID is unable to record 
in the ERMapper compatible .ers header file.

Here is an example of the file.

fftdata Begin
   coeff = {" 1972.614766  -0.006298246813
             -0.01090308443  0  0  0  0  0  0  0 " }
   m_extend = 0
   n_extend = 0
   o_numx = 150
   o_numy = 150
   window = 0
   fft_direction = r
   comment = {" Detrend  Expand  Fill  Ffft 
                CNDN  Rfft  Red  Bool " }
fftdata End

Contact our technical support service if you require information about these files.

See "Grid dataset file and directory structure" in INTREPID database, file and data 
structures (R05) and "INTREPID Auxiliary files" in INTREPID database, file and 
data structures (R05) for general information about the corresponding topics.
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Post-Filter Transformation (OldGridFFT)
After you specify an output dataset, INTREPID displays the Post-Filter 
Transformation dialog box.

>> To specify post-filter transformation
1 If you wish to transform the dataset from the spectral to the spatial domain, turn 

on Reverse transform. 
2 If you wish to reduce an expanded dataset to its original size, turn on the Reduce 

dataset.  (See "Reducing the dataset" in INTREPID spectral domain operations 
reference (R14) for information).

3 If you wish to restore to null the interpolated values in a dataset, turn on the 
Regenerate data gaps.  (See "Regenerating the data gaps" in INTREPID spectral 
domain operations reference (R14) for information).

4 If you wish to replace the mean and restore any trend in the dataset that you had 
previously removed, turn on Reproduce trend.  (See "Reproducing the trend" in 
INTREPID spectral domain operations reference (R14) for information).

5 Choose OK.
6 If you turned on Regenerate data gaps, INTREPID will need to refer to the 

original spatial domain dataset to locate them.  It displays the Open original 
dataset for gap generation dialog box.  Specify the original spatial domain input 
dataset.

If you wish only to examine the results of the pre-filter transformation, and you are 
therefore specifying an output dataset only as a formality, turn off all check boxes.  
This will speed up the pre-filter transformation process.  See Previewing the 
transformed input dataset (OldGridFFT) below for further details about this 
technique.

The radially averaged power spectrum graph (OldGridFFT)
See "Power spectrum graphs" in INTREPID spectral domain operations reference 
(R14) for an introduction to power spectrum graphs.Viewing the power spectrum 
graph

>> To view a radially averaged power spectrum graph of the input and 
output datasets with the current filter selection
Choose Radial Power Spectrum from the Window menu.  
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INTREPID displays the Spectral Domain Grid Filters Spectrum window containing 
the graph.

The input dataset power spectrum is shown in blue and the filtered dataset power 
spectrum in red.

>> To return to the Spectral Domain Grid Filters Main window
Choose Main from the Window menu.

Querying the power spectrum graph (OldGridFFT)
INTREPID can calculate and display the y intercept and the slope of the line joining 
any two points in the graph and the corresponding Spector Grant depth estimate1.  
You can use the intercept and slope in the Matched filter (See Matched Filter 
(OldGridFFT) below for details).

>> To display the y intercept and slope of the line joining any two points in 
the Power Spectrum graph and the corresponding Spector Grant depth 
estimate
Click the two points.  INTREPID displays the data in a message box.

>> To display an intercept/slope/depth estimate report for another pair of 
points
Dismiss the message box if it is still present, click once anywhere on the graph to 
release the previous line segment selection, then click the two required points.

1. Spector, A., and Grant, F.S., (1970), Statistical methods for interpreting aeromagnetic 
data, Geophysics 35, 293–302
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Clearing the power spectrum display (OldGridFFT)
After applying a filter, if you change the filter specifications and choose Apply again, 
the previous output power spectrum graph may remain in the display as well as the 
spectrum of the new filter results. This may continue happening until you clear all of 
the specifications.  See Specifying and removing grid filters (OldGridFFT) below for 
instructions.

Previewing the transformed input dataset (OldGridFFT)
Before applying any filters you can view 
• The colour display of the transformed input dataset in the Input Spectrum 

Display area and 
• The Power Spectrum graph  of the transformed input dataset

>> To preview the transformed input dataset
1 Specify the input dataset with pre-filter transformation as required by you.
2 Specify an output dataset.  (You may delete this at any time after the session.)
3 Turn off all check boxes in the Post-Filter Transformation dialog box.  This will 

speed up the output part of the process which is not required for your purposes at 
this time.

4 Choose Apply.  
INTREPID will carry out the transformation and display the input dataset using 
pseudocolour in the Input Spectrum and Filtered Spectrum boxes.  You can examine 
the power spectrum graph by choosing the Radial Power Spectrum from the Window 
menu.

If you have already applied filters and then wish to view the transformed input 
dataset without filters, choose Clear Filter, then Apply.  To speed up the process you 
could also respecify the output dataset with all post-filter transformation options 
turned off.

The Spectral Domain Grid Filters (OldGridFFT)
Information about filters and parameters (OldGridFFT)

See "Spectral domain filters available" in INTREPID spectral domain operations 
reference (R14) for a complete list of the filters available, including a description and 
an explanation of the purpose of each parameter.

Specifying and removing grid filters (OldGridFFT)
 You can specify a number of filters for INTREPID to use in the Spectral Domain Grid 
Filters process.  INTREPID will apply the filters one after the other to the data when 
you choose Apply.  You can modify your filter selection as required.

>> To specify a filter for the Spectral Domain Grid Filters process, 
1 Choose the filter from its corresponding menu.  INTREPID  displays a dialog box 

for you to specify the filter parameters.  
2 Specify the parameters and choose OK.  INTREPID places a check mark against 

each filter you select in its corresponding menu.
Library | Help | Top © 2012 Intrepid Geophysics  | Back | 



INTREPID  User Manual Old spectral domain grid filters (OldGridFFT) (T38) 10
Library | Help | Top  | Back | 
>> To remove a filter from your filter selections
Choose the filter again from its menu.  INTREPID will remove the filter and turn off 
the check mark in the menu.  

If you have already applied the current set of filters, the previous output power 
spectrum graph will remain in the display as well as the spectrum of any new filter 
results.

>> To remove all filter specifications
Choose Clear Filter.  INTREPID will clear all filter specifications and all output 
power spectrum curves, but retain your input/output dataset selection and pre- and 
post-filter transformation specifications.

>> To modify a filter specification
Remove the filter (see above), then respecify it with the new parameters. 

Specifying parameters in Spectral Domain Grid Filters dialog boxes (OldGridFFT)
The Spectral Domain Grid Filters dialog boxes generally have a single text box for 
parameters even if there are several of them.

>> To enter a number of parameters in a single text box
Separate the parameters with spaces and ensure that they are in the order required.  

Here is an example of a dialog box with a number of parameters.

Frequency units and the Spectral Domain Grid Filters tool (OldGridFFT)
The INTREPID power spectrum graphs display frequency scale in cycles/km. 

The Spectral Domain Grid Filters tool uses cycles/m for cutoff frequencies in its dialog 
boxes.  If you use the power spectrum graph to assist you in choosing a cutoff 
frequency for a filter, divide the frequency by 1000 to convert it to cycles/m before 
specifying it in the filter dialog box.
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Summary of menus, filters and parameters (OldGridFFT)
This table contains a summary of the filters, their variations and the menus in which 
you can find them.

Menu Filter Type Parameters Required

Gradients Derivative 
(gradient)

Vertical order

X (East)

Y (North)

Reductions Reduction Equator inclination, declination

Pole inclination, declination, latitude for amplitude limit 

Pole (low 
Latitude)

Continuations Continuation Downwar
d

level, central wavenumber (frequency), degree of 
rolloff

Upward level

Standard Matched 4 filter coefficients  b, h, B, H

Low Pass cutoff wavenumber (cutoff frequency)

High Pass

Band Pass Pass low and high cutoff wavenumbers (frequencies)

Reject

Cosine 
Rolloff

Pass low and high cutoff wavenumbers (frequencies),  
degree of cosine function

Reject

Butterworth Pass Central wavenumber (frequency), degree of 
Butterworth filter

Reject

Gauss Pass standard deviation

Reject

General 
Symmetric

wavenumber (frequency) increment, filter 
coefficients

Directional Directional 
Pass

Pass low and high cutoff angles

Reject

Directional 
Cosine

Pass filter direction, degree of cosine function

Reject
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Specifying the Earth's core magnetic field direction and intensity 
(OldGridFFT)

If you wish to use a Reduction, Susceptibility or Pseudo Gravity filters (See Reduction 
Filters (OldGridFFT),  Pseudo Gravity transformation (OldGridFFT) and  
Susceptibility filter (OldGridFFT) below) you must specify the direction and strength 
of the Earth's core magnetic field at the  mid point of the dataset.  You can use one of 
the following methods (with corresponding options in the Mag Field menu):
• Choose either the Australian or International Geomagnetic Reference Fields 

(AGRF and IGRF) and specify the survey date and sensor height.  INTREPID will 
calculate the core magnetic field data for you.

• Manually specify the Earth's core magnetic field inclination, declination and 
intensity for the mid point of the dataset.

___

For general information about the GRF, see The geomagnetic reference field in 
INTREPID (R15).

Automatic calculation of field data (OldGridFFT)

>> To automatically calculate the core magnetic field data from the AGRF or 
IGRF model
1 Choose AGRF or IGRF from the Mag Field menu.

INTREPID displays the Enter Date and Sensor Height dialog box.  

Complex Pseudo 
Gravity

(Inclination, declination, field intensity,) 
susceptibility / density contrast ratio, altitude 
separation

Susceptibility 
Map

(Inclination, declination, field intensity,) depth of 
continuation, latitude for amplitude limit, dimension 
of prism

Decorrugatio
n

line spacing, direction along striping

Apparent 
Density

thickness of the Earth model

Menu Filter Type Parameters Required
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2 Enter the date and height in the form of four numbers: day, month, year, height 
(for example 12 10 92 60.0 represents 12 October 1992 and 60.0 metres).  
Choose OK.

3 INTREPID will automatically obtain the latitude and longitude of the mid point 
of the dataset.

4 INTREPID will calculate the core magnetic field strength, inclination and 
declination, then display them in a message box.  

5 Note the values if required.
INTREPID will automatically retain the values and use them 

• As default parameters for Reduction filters,
• As fixed parameters for the Pseudo Gravity and Susceptibility filters.
6 Choose OK.  
Parameters

Values automatically calculated and reported by INTREPID.

Parameter Unit Default value

Date (dd mm yy) 31 12 92

Sensor height m 0

Parameter Unit

Latitude °

Longitude °

Inclination °

Declination °

Field Intensity nT
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Manual specification of field data (OldGridFFT)

>> To manually specify inclination, declination and strength
1 Choose Manual from the Mag Field menu.  

INTREPID displays the Magnetic Field Manual Entry dialog box.

2 Enter the Inclination, Declination and Field Intensity in the text box, separated 
by spaces, then choose OK.

Parameters

Derivative filters (gradient filters) (OldGridFFT)
INTREPID provides a vertical derivative (vertical gradient) filter and horizontal 
derivative filters with respect to the Easterly direction (Horizontal X–Derivative) and 
the Northerly direction (Horizontal Y–Derivative).  You can specify a fractional order 
for the vertical derivative.

See "Single derivative filters" in INTREPID spectral domain operations reference 
(R14) for information about this filter.

>> To specify a Derivative (gradient) filter: 
1 Choose one of the options from the Gradients menu.

Parameter Unit Default value

Inclination ° –60

Declination ° 0

Field Intensity nT 50000
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2 If you choose Vertical, INTREPID displays the Order of Differentiation dialog box.

3 Edit the parameter as required and choose OK. 
Parameters

Reduction Filters (OldGridFFT)
See "Reduction filters (reference)" in INTREPID spectral domain operations 
reference (R14) for information about these filters.

>> To specify a Reduction filter: 
1 Ensure that you have specified the Earth's core magnetic field data.  (See 

Specifying the Earth's core magnetic field direction and intensity (OldGridFFT)).  
2 Choose one of the options from the Reductions menu.

INTREPID displays a dialog box for entering parameters.  The dialog box will 
already contain as defaults the Earth's core magnetic field data that you have 
calculated or specified.

3 Edit the parameters as required and choose OK..

Reduction to the pole (standard and low latitude) (OldGridFFT)
If you choose To Pole or To Pole Low Latitude from the Reductions menu, INTREPID 
displays the Reduction to the Pole Parameters dialog box.  

Edit the parameters as required and choose OK.

See "Reduction filters (reference)" in INTREPID spectral domain operations 
reference (R14) and, specifically "Reduction to the Pole (reference)" in INTREPID 
spectral domain operations reference (R14) for information about this filter.

Parameter Unit Default value

Order of Differentiation (Vertical derivative only) 1
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Parameters

Reduction to the Equator (OldGridFFT)
If you choose To Equator from the Reductions menu, INTREPID displays the 
Reduction to the Equator Parameters dialog box.  

Edit the parameters as required and choose OK.

See "Reduction filters (reference)" in INTREPID spectral domain operations 
reference (R14) for information about this filter.
Parameters

Continuation Filters (OldGridFFT)
See "Continuation filters (reference)" in INTREPID spectral domain operations 
reference (R14) for information about these filters.

>> To specify a Continuation filter: 
1 Choose Downward or Upward from the Continuations menu.

INTREPID displays the Level of Continuation dialog box.  
2 Edit the parameters as required and choose OK.

Parameter Unit Default value

Inclination ° calculated or specified

Declination ° calculated or specified

Latitude for Amplitude Limit ° 20 (standard) 
10 (low latitude)

Parameter Unit Default value

Inclination ° calculated or specified

Declination ° calculated or specified
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Upward Continuation (OldGridFFT)
If you choose Upward from the Continuations menu, INTREPID displays the Upward 
Continuation dialog box.

Edit the parameter as required and choose OK.

See "Continuation filters (reference)" in INTREPID spectral domain operations 
reference (R14) and, specifically "Upward Continuation filter (reference)" in 
INTREPID spectral domain operations reference (R14) for information about this 
filter.
Parameters

Downward Continuation (OldGridFFT)
If you choose Downward from the Continuations menu, INTREPID displays the 
Downward Continuation dialog box.

Edit the parameters as required and choose OK.

See "Continuation filters (reference)" in INTREPID spectral domain operations 
reference (R14) and, specifically "Downward Continuation filter (reference)" in 
INTREPID spectral domain operations reference (R14) for information about this 
filter.
Parameters

Standard Filters (for frequency ranges) (OldGridFFT)
See "Filters for frequency ranges (pass filters)" in INTREPID spectral domain 
operations reference (R14) for information about these filters.

Parameter Unit Default value

Level of Continuation m 100

Parameter Unit Default value

Level of Continuation m 50

Degree of Rolloff 5

Median Frequency of Rolloff 
(Median Wavenumber of Rolloff)

cycles/m 0.005
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>> To specify a Standard filter:
1  Choose one of the options from the Standard menu.  

INTREPID displays a dialog box for entering parameters.
2 Edit the parameters as required and choose OK.

Low Pass (OldGridFFT)
Here is an illustration of the effect of a low pass filter:

If you choose Low Pass from the Standard menu INTREPID displays the Low Pass 
Parameters dialog box. 

Edit the parameter as required and choose OK.

See "Filters for frequency ranges (pass filters)" in INTREPID spectral domain 
operations reference (R14) and, specifically "Low pass filter (reference)" in 
INTREPID spectral domain operations reference (R14) for information about this 
filter.
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Parameters

High Pass (OldGridFFT)
Here is an illustration of the effect of a high pass filter:

If you choose High Pass from the Standard menu, INTREPID displays the High Pass 
Parameters dialog box. 

Edit the parameter as required and choose OK.

See "Filters for frequency ranges (pass filters)" in INTREPID spectral domain 
operations reference (R14) and, specifically "High pass filter (reference)" in 
INTREPID spectral domain operations reference (R14) for information about this 
filter.
Parameters

Parameter Unit Default value

Cutoff wavenumber (frequency) cycles/m 99999

Parameter Unit Default value

Cutoff wavenumber (cutoff frequency) cycles/m 0
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Band Pass (OldGridFFT)
Here is an illustration of the effect of a band filter with the Pass option selected:

If you choose Band Pass from the Standard menu, INTREPID displays the Band Pass 
Parameters dialog box. 

Edit the parameters as required and choose OK.

See "Filters for frequency ranges (pass filters)" in INTREPID spectral domain 
operations reference (R14) and, specifically "Band pass filter (reference)" in 
INTREPID spectral domain operations reference (R14) for information about this 
filter.
Parameters

Parameter Unit Default value

Low cutoff wavenumber (cutoff frequency) cycles/m 0

High cutoff wavenumber (cutoff frequency) cycles/m 99999

Pass / Reject (Pass = Pass the inside of the band) Pass
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Cosine Rolloff Filter (OldGridFFT)
Here is an illustration of the effect of a cosine rolloff filter with the Pass option 
selected. 

If you choose Cosine Rolloff from the Standard menu, INTREPID displays the Cosine 
Rolloff Parameters dialog box. 

Edit the parameters as required and choose OK.

See "Cosine rolloff filter (reference)" in INTREPID spectral domain operations 
reference (R14) for information about this filter.
Parameters

Butterworth Filter (OldGridFFT)
If you choose Butterworth from the Standard menu, INTREPID displays the 
Butterworth Filter Parameters dialog box. 

Edit the parameters as required and choose OK.

Parameter Unit Default value

Low cutoff frequency (for rolloff range) cycles/m 0

High cutoff frequency (for rolloff range) cycles/m 99999

Degree of cosine function 2

Pass / Reject (Pass=Pass the lower frequencies) Pass
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See "Butterworth filter (reference)" in INTREPID spectral domain operations 
reference (R14) for information about this filter.
Parameters

Gauss Filter (OldGridFFT)
If you choose Gauss from the Standard menu, INTREPID displays the Gauss Filter 
Parameters dialog box. 

Edit the parameters as required and choose OK.

See "Gauss filter (reference)" in INTREPID spectral domain operations reference 
(R14) for information about this filter.
Parameters

Matched Filter (OldGridFFT)
Here is an example of a matched filter using the coefficients illustrated in the dialog 
box below.

Parameter Unit Default value

Central wavenumber (central frequency) cycles/m 0.01

Degree of Butterworth function 8

Pass / Reject (Pass=Pass the lower frequencies) Pass

Parameter Unit Default value

Standard deviation cycles/m 0.01

Pass / Reject (Pass=Pass the lower frequencies) Pass
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>> To use the matched filter
1 If you wish to enter the matched filter coefficients directly without INTREPID 

assisting you to calculate them, go to step 5.
2 View the power spectrum graph for the input dataset (See The radially averaged 

power spectrum graph (OldGridFFT) above for instructions).
3 Obtain and make a note of slope and y intercept readings for the regional line 

segment (See The radially averaged power spectrum graph (OldGridFFT) above 
for instructions). 

4 Obtain and make a note of slope and y intercept readings for the near surface line 
segment.

5 Choose Matched from the Standard menu.  INTREPID displays the Matched 
Filter Parameters dialog box.  

6 Edit the parameters as required and choose OK.
See "Matched filter (reference)" in INTREPID spectral domain operations reference 
(R14) for information about this filter.
Parameters

General Symmetric Filter (OldGridFFT)
If you choose General Symmetric from the Standard menu, INTREPID displays the 
General Symmetric Filter Parameters dialog box. 

Edit the parameters as required and choose OK.

See "General symmetric filter (reference)" in INTREPID spectral domain operations 
reference (R14) for information about this filter.

Parameter Unit Default value

b (near surface slope) 0

h (near surface y intercept) energy 1

B (regional slope) 0

H (regional intercept) energy 1
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Parameters

Directional Filters (OldGridFFT)
See "Directional Filters" in INTREPID spectral domain operations reference (R14) for 
information about these filters.

>> To apply Directional filters:
1 Choose Pass or Cosine from the Directional menu.  

INTREPID displays the corresponding parameters dialog box.
2 Edit the parameters as required and choose OK.

Directional Pass Filter (OldGridFFT)
Here is an illustration of the effects of a directional pass filter.

Parameter Unit Default value

Wavenumber increment (frequency increment) cycles/m 0.001

Filter coefficients (8) 1, 1, 1, 1, 0.8, 0.5, 0.2, 0 (This is a 
low pass filter with a rolloff)
Library | Help | Top © 2012 Intrepid Geophysics  | Back | 



INTREPID  User Manual Old spectral domain grid filters (OldGridFFT) (T38) 25
Library | Help | Top  | Back | 
If you choose Pass from the Directional menu, INTREPID displays the Directional 
Pass Parameters dialog box. 

Edit the parameters as required and choose OK.

See "Directional pass filter (reference)" in INTREPID spectral domain operations 
reference (R14) for information about this filter.
Parameters

Directional Cosine Filter (OldGridFFT)
Here is an illustration of the effects of a directional cosine filter.

Parameter Unit Default value

Low cutoff angle ° 75

High cutoff angle ° 105

Pass / Reject (Pass=Pass the data between Low and High cutoff angles) Pass
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If you choose Cosine from the Directional menu, INTREPID displays the Directional 
Cosine Parameters dialog box. 

Edit the parameters as required and choose OK.

See "Directional cosine filter (reference)" in INTREPID spectral domain operations 
reference (R14) for information about this filter.
Parameters

Complex filters (OldGridFFT)
The Complex filters are commonly used special combinations of filters.

>> To specify a Complex filter: 
1 If you are using the Pseudo Gravity or Susceptibility filters, ensure that you have 

specified the Earth's core magnetic field data (See Specifying the Earth's core 
magnetic field direction and intensity (OldGridFFT) above).  

2 Choose the option you require from the Complex menu.  

INTREPID displays a dialog box for entering parameters.
3 Edit the parameters as required and choose OK.

Pseudo Gravity transformation (OldGridFFT)

>> To specify a Pseudo Gravity filter
1 Make sure you have specified the core magnetic field direction and intensity for 

the survey (See Specifying the Earth's core magnetic field direction and intensity 
(OldGridFFT) above for instructions.)  INTREPID will automatically use these 
values for the filter.

Parameter Unit Default value

Filter direction ° 90 

Degree of cosine function 2

Pass / Reject (Pass=Pass the data near the filter direction within the 
cosine function rolloff range.)

Pass
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2 Choose Pseudo Gravity from the Complex menu.  INTREPID displays the Pseudo 
Gravity Parameters dialog box. 

3 Edit the parameters as required and choose OK.
See "Pseudo gravity transformation (reference)" in INTREPID spectral domain 
operations reference (R14) for information about this filter.
Parameters

Susceptibility filter (OldGridFFT)
Here is an illustration of the effect of the Susceptibility filter:

>> To specify a Susceptibility filter
1 Make sure you have specified the core magnetic field direction and intensity for 

the survey (See Specifying the Earth's core magnetic field direction and intensity 
(OldGridFFT) above for instructions.)  INTREPID will automatically use these 
values for the filter.

2 Choose Susceptibility from the Complex menu.  INTREPID displays the 
Susceptibility Parameters dialog box. 

Parameter Unit Default value

(Inclination) °

(Declination) °

(Field Intensity) nT

Susceptibility / Density Contrast Ratio 1

Altitude Separation m 0
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3 Edit the parameters as required and choose OK.
See "Susceptibility filter (reference)" in INTREPID spectral domain operations 
reference (R14) for information about this filter.
Parameters

Decorrugation (OldGridFFT)
If you choose Decorrugation from the Complex menu, INTREPID displays the 
Decorrugation Parameters dialog box. 

Edit the parameters as required and choose OK.

See "Decorrugation filter (reference)" in INTREPID spectral domain operations 
reference (R14) for information about this filter.
Parameters

Apparent Density (OldGridFFT)
Here is an illustration of the effects of an Apparent Density filter.

Parameter Unit Default value

(Inclination) °

(Declination) °

(Field Intensity) nT

Depth of continuation m 0

Latitude for amplitude limit ° 20

Dimension of prism m 100

Parameter Unit Default value

Line Spacing m 100

Direction Along Striping from North ° 90 (East–West)
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If you choose the Apparent Density from the Complex menu, INTREPID displays the 
Apparent Density Parameters dialog box. 

Edit the parameters as required and choose OK.

See "Apparent density filter (reference)" in INTREPID spectral domain operations 
reference (R14) for information about this filter.
Parameters

Apply (OldGridFFT)
When you choose Apply INTREPID will perform the processing that you have 
specified.  Before you choose Apply, you must have specified the input and output 
dataset names, the type of processing you require and parameters that you wish 
INTREPID to use.

When INTREPID has completed the process it displays the Filtering process 
successfully completed message box.

Choose OK to dismiss the box.

Stop (OldGridFFT)

>> To abandon processing after it has started
Choose Stop from the Spectral Domain Grid Filters Main window.

Exit (OldGridFFT)

>> To exit from the Spectral Domain Grid Filters tool
Choose Quit from the File menu, INTREPID will exit from the Spectral Domain Grid 
Filters tool.

Parameter Unit Default value

Thickness of the Earth Model m 50
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Other uses of the pre-filter and post-filter transformations (OldGridFFT)
You can perform any of the following pre-filter and post-filter transformation tasks 
separately on a dataset.
• Removing and restoring trends in datasets, 
• Expanding and restoring the dimensions of data grids,
• Filling data gaps in grids by interpolation. 
• Finding and removing interpolated values in grids.

>> To use the Pre-Filter and Post-Filter Transformations separately on a 
dataset, 
1 Specify the input and output datasets with the pre-filter and post-filter processes 

you require.  (See Specifying Input and Output (Filtered) Datasets (OldGridFFT), 
Pre-Filter Transformation (OldGridFFT) and Post-Filter Transformation 
(OldGridFFT) above for details).

2 Choose Apply without having chosen any grid filters.  INTREPID will perform the 
pre-filter and/or post-filter processes you have specified, saving the results to the 
output dataset.

Help (OldGridFFT)
You can use the Help menu to display help text on the topics shown in the menu 
illustration below.

Displaying options and using task specification files  (OldGridFFT)
Displaying options (OldGridFFT)

You can view a list of the filters selected in the status area at the bottom of the 
Spectral Domain Grid Filters main window.
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Using task specification files (OldGridFFT)
You can store sets of file specifications and parameter settings for Spectral Domain 
Grid Filters in task specification (.job) files.  

>> To create a task specification file with the Spectral Domain Grid Filters 
tool
1 Specify all files and parameters.
2 If possible, execute the task (choose Apply) to ensure that it will work.
3 Choose Save Options from the File menu.  Specify a task specification file 

(INTREPID will add the extension .job)  INTREPID will create the file with the 
settings current at the time of the Save Options operation.

For full instructions on creating and editing task specification files see INTREPID 
task specification (.job) files (R06).

>> To use a task specification file in an interactive Spectral Domain Grid 
Filters session
Load the task specification (.job) file (File menu, Load Options), modify any settings 
as required, then choose Apply. 

>> To use a task specification file for a batch mode Spectral Domain Grid 
Filters task
Type the command gfilter.exe with the switch –batch followed by the name (and 
path if necessary) of the task specification file.  

For example, if you had a task specification file called surv329.job in the current 
directory you would use the command

gfilter.exe –batch surv329.job
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Task specification file example and notes (OldGridFFT)
Here is an example of a Spectral Domain Grid Filters task specification file.

Process Begin
   Name = GridFilter
   Input = /disk1/survey/mlevel_grid
   Output = /disk1/survey/vd_grid1
   Parameters Begin
      Date = "31 12 92 0.0"
      Elevation = 0.0
      Inclination = 0.0
      Declination = 0.0
      FieldStrength = 0.0
      Detrend = Yes
      DetrendValue = 1
      GridFill = Yes
      GridExpand = Yes
      MaxEntropy = No
      ReverseFFT = Yes
      Reduce = Yes
      Regenerate = No
      Trend = No
      CosineBell = Yes
      Hanning = No
      Hamming = No
      Blackman = No
      Triangular = No
      saveFFTbs = Yes
      Filter Begin
         Type = VERTICAL
         Order = ".75"
      Filter End
   Parameters End
Process End

Notes (OldGridFFT)
• To specify a different input grid for regenerating the data gaps, insert an 

Input_Orig = line before the Parameters Begin – End block.  For example,
Input_Orig = /disk1/survey/raw_grid

• You can specify a compound filter by adding Filter1 Begin – End, Filter2 
Begin – End, ... blocks after the original Filter Begin – End block.

For example, the filter blocks could be as follows

      Filter Begin
         Type = VERTICAL
         Order = ".75"
      Filter End
      Filter1 Begin
         Type = UPWARD
         Order = "100"
      Filter1 End
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